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1. Welcome 
VersionTracker Pro is the fastest, most flexible way to keep your software current.  
VersionTracker Pro has three primary components: 
 

• VersionTracker Pro software- automatically tracks your installed software and notifies 
you when new updates are available.  

• All the advanced My Tools features on VersionTracker.com- including email alerts, 
online report center and more. 

• Custom view of the VersionTracker.com website- specify the display and access 
subscriber-only features like Advanced Search. 

 

Quick Tip- To access your online features, go to http://www.versiontracker.com/tools and login. 
 
What’s New in VersionTracker Pro 3.5: 

• Download sharing via Rendezvous accelerates downloads within your local network 
• New preview pane offers detailed information about each update 
• Multiple version support allows review and download of older updates 
• Update notification window gives an elegant view of incoming updates 
• Dock badging provides at-a-glance update info in the dock 
• Enhanced download and install feature 
• Improved download resuming capability 
• Improvements to proxy support 
• Reduced CPU and memory requirements 
• User interface refinements 
• Internal improvements to scanning 
 

2. System Requirements 
• Mac OS X 10.2 or higher (10.3.x and 10.4.x users should upgrade to VersionTracker Pro 

4.0) 
• Installation of Safari 1.0 or higher 
• Internet connection 

 

3. Known Issues 
For a list of known issues, the latest documentation, downloads and FAQs go to: 
http://www.versiontracker.com/faq 
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4. Installing VersionTracker Pro 
Just follow these steps to install the Mac software.  For installation of the Windows or Mac OS 9 
software refer to the appropriate Quick Start Guide located at http://www.versiontracker.com/faq.   
 
Installation of VersionTracker Pro is quick and easy. Just follow these steps to get started. 
 

1.  If you have a previous version of VersionTracker Pro installed, drag it to the trash. 
2.  Drag the VersionTracker Pro application into your Applications folder. 
3.  Launch VersionTracker Pro. 

 
Note- If you have successfully registered a previous version, you will skip the following steps. 
 

4. When you launch VersionTracker Pro, a registration dialogue window will pop up. 
• If you purchased or activated VersionTracker Pro online from our website, skip to 

“Step 2: Enter Your Account Information” and enter the email address and password 
that you used to create your account. (Installation Complete) 

• If you don’t have a VersionTracker account, click on the “Purchase” button and your 
browser will take you online where you can purchase Pro and create an account.  
After purchasing the product, go to “Step 2: Enter Your Account Information”. 

• If you purchased VersionTracker Pro from one of our partners, or received a box, click 
on the “Activate Serial” button and your browser will take you to our site where you 
can activate the product.  After activation, go to “Step 2: Enter Your Account 
Information” 

• If you want to try VersionTracker Pro, click on the “Free Trial” button and your browser 
will take you to our site where you can activate your trial.  After trial activation, go to 
“Step 2: Enter Your Account Information” 

 
Image A: Registration Dialogue 
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You are now ready to start using VersionTracker Pro.  VersionTracker Pro will scan your 
computer and connect online to the VersionTracker Database in order to provide you with the 
latest versions of the software you have installed.  For more information refer to the 
Macintosh 3.5 User Guide and additional documentation located at 
http://www.versiontracker.com/faq. 
 

Image B:  Watch List 
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5. VersionTracker Pro Software: A tour 
 
A. Interface- Watch List, Daily Updates and Search: 
Watch List Tab 
The Watch List is the main VersionTracker Pro interface.  Once installed, the software will 
automatically scan your hard drive for Mac OS X files.  This initial scan will tell you what Mac OS 
version you are running, and all the applications, frameworks, kernel extensions etc. that you 
have recently used. 
 
By default the Watch List only shows items that are tracked in the VersionTracker Database.  
Some items that you have installed do not have version numbers, are a part of the OS or are not 
updated, thus; these items are not tracked by VersionTracker.  By default VersionTracker Pro 
hides these items; you can show all items regardless if they are updated or not by selecting the 
View Menu -> Show Untracked Items.  
 
Quick Tip- Use the VersionTracker Pro -> Preferences menu item to edit your scanning 
preferences (can include Mac OS 9 files and additional drives).  
 

Image C:  Watch List 
 

 
 
 

Watch List Options 
The items on your Watch List can be sorted by clicking on the “DL”, “Name”, “My Version”, 
“Current”, “OS” or “Kind” column headers.  By default the sort is by “My Version”, which will list 
your out-of-date items to the top of the Watch List. 
 

• When you sort by “DL”, it will list the items in your Watch List that you have downloaded.  
A check mark means the item was downloaded using the VersionTracker Pro Software. 

• When you view the items by “Name”, the items appear in alphabetical order.  
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• When you view the items by “My Version”, the items that are out-of-date are displayed at 
the top of the list with the version number in red, followed by “skipped” items in blue. The 
rest of the items are displayed in alphabetical order.  

• When you view the items by “Current”, items with current version information will be 
displayed alphabetically at the top of the list, followed by items without version 
information also listed in alphabetical order. 

• When you view the items by “OS”, Mac OS X items are sorted to the top. 
• When you view the items by “Kind”, applications are sorted to the top of the list followed 

alphabetically by other utilities like extension, file system and framework items. 
• Double clicking on an item brings you to that version’s Product Page on VersionTracker.com. 

 
Quick Tip- You can reverse the sort order by clicking on the “arrow icon” located in the column 
header.  In addition, the column display is fully customizable – drag and drop to change the sort 
order – and use the View -> Columns menu to add/remove columns in the Watch List tab, Daily 
Updates Tab and Search Tab. 
 
Daily Updates Tab 
A list of the latest software updates posted to the VersionTracker.com website.  Updates from the last 
four days are provided and you can sort by all the available columns including rating and download 
count. 
 
Double clicking on an item brings you to that version’s Product Page on VersionTracker.com.  A 
product icon is the notification that the specific update is installed on your computer. 
 
 
Search Tab 
The Search Tab displays the results of your last search query.  Items can be sorted by all the available 
columns. 
 
Double clicking on an item brings you to that version’s Product Page on VersionTracker.com.  A 
product icon is the notification that the specific update is installed on your computer. 
 
Quick Tip- Use the arrow icon to the right of the magnifying glass to specify what  platforms you 
want to search.  The default search is Mac OS X. 
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B. Main Features: 
Preview Pane 
When an item in the Watch List is highlighted, the preview pane will display additional information 
about a product. This information includes a short description, path location, product description, 
what’s new in this version details, system requirements, download count, user rating and more. 
 
 

Image D:  Preview Pane 
 

 
 
 
Downloading and the Download Manager 
Highlighting an item and clicking “Download” will begin downloading the selected version into 
your specified download location. You can choose to download more than one item at a time 
(using the shift key). If you do so, each download will take place sequentially. 
 
Note- VersionTracker Pro downloads items directly from the product vendor. If the product vendor 
requires you to fill out a form before you can download their software, then VersionTracker Pro 
will open your web browser to the appropriate form page. 
 
VersionTracker Pro also includes a Download Manager with pause and resume options. 

 
Image E:  Download Manager 

 

 
 
Quick Tip- The Download Manager can be accessed via the Windows -> Downloads Menu Item. 
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Download Sharing via Rendezvous 
Faster downloads and save bandwidth with Rendezvous download sharing.  Locate and find local 
network copies of software updates downloaded using VersionTracker Pro. 
 
By default, all downloads from the VersionTracker Pro software are stored in a “VersionTracker 
Downloads” folder.  This folder is accessible to other users within your local network via Rendezvous. 
 
VersionTracker Pro automatically determines if a requested download is available from a local peer.  If 
a download is being shared you will see the text “from local peer” to the right of the transmission 
speed.  Download performance will vary based on your network connection. 
 

Image F:  Download Sharing 

 
 
Quick Tip- In Safari, one of the default bookmarks is a Rendezvous directory that automatically 
broadcasts the download folders of all other computers on your local network running Pro. 
 
 
Download and Install 
VersionTracker Pro gives you the ability to download and automatically install selected and tested 
items including most application drag installs, .pkg installers and launchable installers, patchers 
and updaters.   
 
For MindVision Installer VISE installers, MindVision FileStorm installers, Custom 
installers/patchers, StuffIt InstallerMaker installers and Single file non-app patches the installers 
will launch but can’t be run automatically. Your first installation will display a dialogue window with 
additional information. 
 

Image G:  Download and Install 

 
 
Quick Tip- Advanced users can try the install feature on all items by checking the “Allow 
installation of untested items” in the VersionTracker Pro preferences. 
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Download Scheduling 
Download updates on your schedule.  With VersionTracker Pro you can have your updates 
automatically downloaded at the time most convenient to you.  Set the schedule using the 
VersionTracker Pro preferences accessible from the VersionTracker Pro -> Preferences Menu 
Item. 
 

Image H:  Download Scheduling 
 

 
 
 
Multiple Versions- review and download older updates 
Select the update that is right for you.  Don’t want to upgrade to a beta release, or a paid version?  
Or do you have an outdated piece of software that requires the “dot” releases to be applied 
before you can update to the current version?   
 
With VersionTracker Pro you can view ALL the updates available to you- from your version to the 
current version. 
 

Image I:  Multiple Versions 
 

 
 
 
 
Update Notification Window 
Software updates will be displayed in a notification window.  This gives you a quick view into the 
latest software updates. 
 

Image J:  Notification Window 
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C. Toolbar: 
Toolbar 
The main toolbar is fully customizable.  Control / click to bring up the customization pane.   
 

Image K:  Toolbar Customization Pane 
 

 
 
 
Toolbar Features 
Default Toolbar set / order. 
 

• Download- Download the selected items. 
• Install- VersionTracker Pro gives you the ability to download and automatically install selected 

items including most application drag installs, .pkg installers and launchable installers, 
patchers and updaters.  For MindVision Installer VISE installers, MindVision FileStorm 
installers, Custom installers/patchers, StuffIt InstallerMaker installers and Single file non-app 
patches the installers will launch but can’t be run automatically. Your first installation will 
display a dialogue window with additional information. 

• Skip Version- Don't want to update to the current version but want to be notified about the 
next one?  Perfect for beta releases or paid upgrades.  Clicking “Skip Update” will mark 
the product as blue in your Watch List. 

• Inspect- Shows where the file is located and additional file details including the download 
url. 

• Check for Updates- Clicking the “Check for Updates” button will cause VersionTracker 
Pro to go online and connect to the VersionTracker Database giving you the latest 
versions of the software in your Watch List and Daily Updates Tab.  You need to have an 
active Internet connection. 

• Stop- Stops checking for Updates. 
• Search- The search box allows you to search for software from your desktop.  The results 

will be shown on the Search Tab. 
 
Other Toolbar Options:  

• Remove - Highlighting an item in your Watch List, and clicking the “Remove” button, will 
remove the item. This item will not return until you reset your Watch List or add it back 
manually. 

• Add - Clicking “Add” will bring up a navigational dialog that allows you to find items on 
your hard drive and add them to your Watch List manually.   

 
Quick Tip- You can view the Toolbar as icons and text, Icons only or Text only. 
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D. Menu Items: A Review of the Main Menu Items and Features 
VersionTracker Pro Menu 

-> Preferences- This menu item has seven panes where you can set and edit your 
VersionTracker Pro software preferences. 

1. Updates Pane:  
You can set VersionTracker Pro to automatically check for updates every hour, every four 
hours, every day or every week (you need to have an active Internet Connection to 
complete a successful check-in). Selecting the manual option sets VersionTracker Pro to 
only check for updates when you click the “Check for Updates” button.   
• Checking the “badge dock icon” option will show the number of out-of-date items in 

your Watch List above the dock icon. 
• Checking the “display new updates in notification window” option will present you with 

a visual alert when new updates are available. 
o Check for updates on launch and check updates while using battery provide 

additional customization options. 
2. Download Pane:  
You can select the destination for your downloads.  By default, VersionTracker Pro 
creates a download folder on your desktop. 
• Download from local network peers allows you to access other VersionTracker Pro 

download folders within your network.  This item needs to be enabled to access 
faster downloads. 

• Share my downloads with local peers allows other uses to access your 
VersionTracker Pro downloads folder.  If you change the location of your Downloads 
folder, previous downloads will not be able to be accessed by other users. 

• “Download new updates every day at: …” allows you to schedule all new updates to 
be download daily. 

• Checking “allow installation of untested items” will allow you to attempt to install all 
products, regardless if they are compatible with your computer.  This option is only 
recommended for advanced users or developers who want to test this feature. (See 
the Toolbar Features Install section above for more information on the Install feature.) 

• Download archiving- allows you to specify the amount of disk space for saved 
downloads.  If you check “delete all downloads after unpacking” other users within 
your local network will not be able to share your downloads (the “share my 
downloads” feature also needs to be enabled). 

3. Scanning Pane: 
Edit your scanning preferences, select what drives you would like to include and the file 
type(s). 

o Software I Use - VersionTracker Pro will compile a list of applications and utilities 
that you have recently launched, as well as system extensions and drivers.  It will 
also periodically scan your system for open applications and add them to the list. 

o All My Software - VersionTracker Pro will list all of the applications it can find on 
your computer. 

o Items I Add - VersionTracker Pro will only track items that you have added 
manually to the Watch List. 

4. Ticker Pane: 
Customizes the display of the VersionTracker Ticker.  The Ticker is a carbonized desktop 
palette featuring the latest updates from the VersionTracker Database. The Ticker is 
updated every 15 minutes if you have an active Internet connection and is accessed via 
the Window -> Ticker Menu item. 
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5. System Info Pane: 
Your system information is used to keep you notified of system updates and to help 
technical support. If you de-select the option to include system Information in your online 
profile, your system information will be deleted from our database the next time 
VersionTracker Pro scans for applications. 
 
6. Network Pane: 
If needed, you can set the VersionTracker Pro client to work with a proxy server. 
 
7. Registration Pane:  
The information you used to register with VersionTracker. If you need to change your 
email address or password, you need to go to https://secure.versiontracker.com first, 
then you can edit your account settings in the VersionTracker Pro software. 

 
File Menu 

-> Save as Text- Allows you to export your watch list into a text file, which can be imported 
into other programs or used for reporting purposes. 

-> Get Info- Same as using the Inspect button. 

-> Get Finder Info - If you want to know more info about the item installed on your hard drive, 
you can highlight the item and select “Get Finder Info”. (Note- Get Info brings up the 
Inspector Pane).  

-> Reveal in Finder - If you want to know where an item is located on your hard drive, you can 
highlight the item and select “Reveal in Finder”. This will open the folder containing the item.   

-> Download- The same functionality as clicking on the “Download” button.  The Watch List 
item(s) that are highlighted will be downloaded. 

-> Download and Install- The same functionality as clicking on the “Install” button.  The Watch 
List item(s) that are highlighted will be downloaded and installed if the install feature is 
enabled for that item. 

-> Download Watch List Updates- Download all the out-of-date applications in your Watch 
List at once. 

-> Download My Download Cart- On VersionTracker.com you are able to add software 
updates to your personal download cart.  VersionTracker Pro allows you to download all the 
items in your download cart. 

-> Skip Version- Don't want to update to the current version but want to be notified about the 
next one?  Perfect for beta releases or paid upgrades.  Clicking “Skip Update” will mark the 
product as blue in your Watch List. 

-> Add Item- Clicking “Add” will bring up a navigational dialog that allows you to find items on 
your hard drive and add them to your Watch List manually. 

-> Remove Item- Highlighting an item in your Watch List, and clicking the “Remove” button, 
will remove the item. This item will not return until you reset your Watch List or add it back 
manually. 

-> Close Window- Closes the active VersionTracker Pro window. 

 

Edit Menu 
Standard edit options. 
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View Menu 
-> Columns- Customize the column display for the active “Tab”- Watch List, Daily Updates or 
Search. 

-> Watch Lists Options- Create and edit Watch Lists.  You are able to create multiple Watch 
Lists, to track different views of your installed software.  

-> Reset Watch List- Will clear your entire Watch List and do a complete scan of your 
computer.  Click on Check for Updates to complete the reset. 

-> Show / Hide Untracked Items- By default the Watch List only shows you items that are 
tracked in the VersionTracker Database.  Some items that you have installed do not have 
version numbers, are a part of the OS or are not updated.  Thus, by default VersionTracker 
Pro hides these items; you can show all items by selecting the View Menu -> Show 
Untracked Items.  
 

Window Menu 
-> Main- Main Watch List interface 
-> VersionTracker Ticker- Carbonized desktop palette featuring the latest updates from the 
VersionTracker Database. The Ticker is updated every 15 minutes if you have an active 
Internet connection. 

• Searching for updates within the ticker- you can search for updates by clicking in the 
“Search VersionTracker” box, typing in your search term and pressing the “Return / 
Enter” key on your keyboard.  You will be connected to the VersionTracker.com 
search results page. 

• Reminder- you can set your VersionTracker Ticker preferences by going to the menu 
item VersionTracker Pro -> Preferences. 

 
Image L:  VersionTracker Ticker 

 

 
 
 

-> Downloads- Download Manager 

-> Inspector- Same as the “Inspect” button on the default Toolbar.  Shows you an items path, 
version and download url. 
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-> Log- Tracks the VersionTracker Pro client activity for one week.  “Activity” refers to the 
scanning information for that particular day.  All other information is logged by product name.   

 
 

Image M:  VersionTracker Log 
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6. My Tools- Features on VersionTracker.com  
To access your online tools, go to http://www.versiontracker.com/tools, and login using the email 
address and password that you used to create your VersionTracker Pro account.   
 
Once the VersionTracker Pro software checks for update, from your online “Computer List”, you 
can keep track of the software installed on multiple computers within the same account.   
 
 

Image Q: My Tools located at http:// /toolswww.versiontracker.com  
 

 
 
 
For more information on all the advanced site features for VersionTracker Pro subscribers refer to 
the: 
 
User guide located at: http://image.versiontracker.com/plus_download/vtplusguide.pdf  
Feature tours at: http://www.versiontracker.com/faq/plustour/index.php  
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7. Contact Information 
Technical and customer support is available by emailing us at support@techtracker.com or by calling 
+1 503.227.2571.  Our hours of operation are Monday through Friday from 8:30am to 5:30pm Pacific 
Standard Time. 
 

8. License 
Upon purchase, you are entitled to a single subscription to VersionTracker Pro.  For full terms 
and conditions, please read through the entire licenses agreement presented during purchase or 
activation of VersionTracker Pro.  For more information, please refer to 
http://www.techtracker.com. 
 

9. Disclaimer of Warranty   
VersionTracker Pro is provided on an “as is” basis, without warranty of any kind, including without 
limitation the warranties of merchantability, fitness for a particular purpose and non-infringement.  
The entire risk as to the quality and performance of the software is borne by you.  Should this 
software prove defective, you and not TechTracker assume the entire cost of any service and 
repair.  In addition, software has inherent security limitations and you must determine that this 
software, as well as any other software that uses data generated by the software, sufficiently 
meets your requirements.  This disclaimer of warranty constitutes an essential part of the 
agreement.  
 
If your CD is defective, TechTracker will send you a replacement at no cost to you.  You can also 
download the latest version of the Mac OS, Mac OS X and Windows software clients at:  
http://www.versiontracker.com/faq. 
 

10. Privacy Statement 
TechTracker does not collect any unnecessary personal information.  The information we collect 
is aggregated solely for the purpose of ensuring your software environment is up-to-date. For 
more information, please refer to http://www.techtracker.com/privacy 
  
TechTracker, the TechTracker logo, VersionTracker Pro, the VersionTracker Pro logo, 
VersionTracker Plus and the VersionTracker Plus logo are either registered trademarks or 
trademarks of TechTracker, Inc. in the United States and/or other countries.  Mac, Mac OS, Mac 
OS X, and the Mac OS logo are the trademarks of Apple Computer Inc., registered in the United 
States and other countries. 
 
Copyright 2003-2006, TechTracker, Inc.  All rights reserved. 
 
TechTracker, Inc. 
55 SW Yamhill Street, 3rd Floor 
Portland, OR 97204 USA 
http://www.techtracker.com 
info@techtracker.com  
 

11. About TechTracker 
TechTracker drives computer stability across the global desktop computing environment through 
software applications and a network of software support Websites. IT administrators, developers 
and end-users collaborate on the TechTracker Network to solve technology problems. For more 
information, please visit http://www.techtracker.com. 
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